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[bookmark: Introduction][bookmark: _bookmark0]Introduction
Creating documents that can be accessed and read by people of all abilities is just as important as creating accessible1 web content.

As a widely used format to communicate information online, PDFs and other common file types should be able to be accessed by all.

Making your content inclusive for all helps enrich your communities’ experiences and gives them the potential to access the content you are providing.

When creating documents, there are a few basic steps that should be followed in order to assure your content is accessible.  The core steps needed for accessibility are:
· Use of styles5 – headings, lists, etc.
· Addition of alternate text6 to images
· Use of tables in an organized and simplified fashion
· Use of descriptive links

The following best practices are provided to help you maximize the accessibility of your Microsoft Office products; including but not limited to Word, Excel and PowerPoint.

Most of the instructions included below apply to all of the Microsoft Office products, and by default the focus is on Microsoft Word. If instructions differ by product, a special section for the product will be included.  Instructions for both Windows and Mac users are included in the training.

[bookmark: _GoBack]Microsoft Office 2016 is my current software running on a Windows 10 device.
Images and instructions may vary slightly if you are using a different version.


1 “Accessible” means a person with a disability is afforded the opportunity to acquire the same information, engage in the same interactions and enjoy the same services as a person without a disability in an equally effective and equally integrated manner, with substantially equivalent ease of use.
2 Disabilities can include impairments such as visual (blind, low vision, aging, color deficient), aural (deaf, low hearing, aging, discrimination, tinnitus, vertigo), mobility (absence of limbs or digits, paralysis, MS, CP, Parkinson’s, aging), cognitive (memory, abstraction, ADHD, DRD, agnosia, acalculia)
3 Accessibility refers to the design of products, devices, services or environments for people who experience disabilities. Digital Accessibility is the ability of a website, mobile application or electronic document to be easily navigated and understood by a wide range of users, including those users who have visual, auditory, motor or cognitive disabilities.
5 Not to be confused with just visual type styling, a type or paragraph style is a predefined visual styling that also includes a structural tag. When these are applied to type, screen readers will be able to recognize the different tag and change in content hierarchy.
6 Alt text provides a textual alternative to non-text content, such as images. Alt text is read by a screen reader in the place of images.




You may notice that some configuration/layout options available to you are not covered in these instructions, such as text boxes and headers and footers.

Text boxes are not accessible in Word. If a box of text is desirable for layout or design purposes, use a table with a single row, single column.  Do not use a text box to insert an image or graphic.

Assistive Technology does not read content located in the header and footer, therefore no vital information should be placed there.



[bookmark: Customize_Ribbons][bookmark: _bookmark1]Customize Ribbons
Before getting started, make sure that you have the following ribbons available in your document. Ribbons are the tabs at the top of the document.


You should have Home, View and Design ribbons. An Accessibility ribbon has been created for Microsoft Word, PowerPoint and Excel for ease of use, follow the instructions below to import the ribbons to the appropriate software.
[bookmark: Add_the_Accessibility_Ribbon][bookmark: _bookmark2][bookmark: Windows_Users]Add the Accessibility Ribbons

NOTE: The rest of the instructions are written with the assumption that the Accessibility ribbon provided is being used for each software. All of the tools can also be found in other ribbons locations.


[bookmark: Styles][bookmark: _bookmark3]Styles
It is a common practice to create a type style by changing the text directly in the document. A user will highlight the text and apply a different font styling: a larger font size, bold formatting, additional spacing (with returns or spaces) etc. While these changes made to the font styling will provide visual structure for some of your users, the document structure needed for navigation by assistive technology users is missing.

[bookmark: bookmark0][image: ]


In order for your document to be accessible, you will need to use pre-defined styles. These aren’t just a good idea – they’re required for accessibility.  Microsoft Office Products provide default styles.


[bookmark: _bookmark4]Modifying Pre-Defined Styles
To modify a pre-defined style, you need to modify the original style.

Step 1: In the Home ribbon, right click on the style in the styles pane and select Modify…

[bookmark: Modifying_Pre-Defined_Styles][image: ]


Step 2: In the Modify Style pop-up window you can easily change the font type, font size, formatting, spacing, color, etc. Click the Format drop-down in the bottom left-hand corner to navigate through other style options.

[image: ]

Step 3: After you’ve adjusted your style, you will want to click the Automatically Update checkbox in the bottom left-hand corner to make sure that any styles already used in your document are automatically updated with the new style settings. This also makes it a lot easier to make changes to large documents!

Step 4: Click OK and your style is modified, and any current use cases will be updated.

NOTE: If you adjust colors, please remember that you need to think about color contrast as an accessibility requirement. 


[bookmark: Headings][bookmark: _bookmark5]Headings
Sighted users often scroll a document or page quickly and look for big, bold text (headings) to get an idea of its structure and content. Screen reader and other assistive technology users also have the ability to navigate Word documents by heading structure, assuming styles are used.
Pages should be structured in a hierarchical manner.
· A Heading 1 is usually a page title or a main content heading. Generally, there is only one such header, and it is usually the most important.
· A Heading 2 is usually a major section heading.
· A Heading 3 is usually a sub-section of the Heading 2.
· A Heading 4 is usually a sub-section of the Heading 3, and so on, ending with Heading 6.


Documents with a proper heading structure provide screen reader and other assistive technology users with the structure to navigate by:
· Viewing a list of all of the headings on the page.
· Choosing top-level headings (Heading 1), next-level headings (Heading 2), third-level headings (Heading 3), and so on.
· Reading or jumping by headings.


[bookmark: _bookmark6]Applying a Heading Style
Step 1: Highlight the text that you would like to apply a heading or other style to (you can also select the style prior to typing the text).

[bookmark: Applying_a_Heading_Style][image: ]

Step 2: In the Home ribbon, click the Style in the Style pane that you would like to apply to the selected text.

[image: ]


Step 3: The style will be applied to the selected text.

To remove styles on text, highlight the text and apply a different style or select the normal style.

If you want to verify that the heading structure of your document is in order, you can click on the Accessibility ribbon (View ribbon for Mac Users) and select Doc. Nav. or Navigation Pane.  This opens a navigation pane on the left side of your document. The Headings tab in the navigation pane shows a hierarchy of headings in your document. They should be nested in an understandable fashion.
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[bookmark: _bookmark8]
[bookmark: _bookmark11][bookmark: Images][bookmark: _bookmark9]Images
[bookmark: Alternate_Text][bookmark: _bookmark10]Alternate Text
Alternate text provides a textual alternative to non-text content, such as images. Alternate text serves several functions:
· It is read by assistive technology in place of images allowing the content and function of the image to be accessible to those with visual or certain cognitive disabilities.
· It is displayed in place of the image in browsers if the image file is not loaded or when the user has chosen not to view images.
The key principle is that computers and assistive technologies cannot analyze an image and determine what it is without alternate text.
The Alternate text should:
· be accurate
· be briefly and clearly expressed
· NOT be redundant
· NOT use the phrases "image of..." "graphic of..." or "logo of..." to describe the image
· NOT be over 125 characters, most screen readers will stop reading after reaching 125 characters.
Logos and other word art are easy to add Alternate Text to; simply restate the text included in the graphic.
Complex images that cannot be explained in 125 characters can be handled in a few different ways.
· Revise the image to make it more accessible.
· Include text on the page content explaining the image in more detail.
· Make the alternate text of the image a link to a separate file that provides the information as text or audio to further explain the image.
Images in general should only be used to support content and not to decorate pages.


[bookmark: Add_Alternate_Text_to_an_Image][bookmark: _bookmark12]Add Alternate Text to an Image
Step 1: Right click on the image and click on “Format Picture”

Step 2: The Alt Text window will open on the right-hand side of your document.

Step 3: Add the alternate text. Remember to use proper capitalization and punctuation.



[bookmark: Decorative_Images][bookmark: _bookmark13]Decorative Images
Some images are not critical to the understanding of the document. If removing the image doesn’t change the understanding of the document, mark it as decorative. As always, avoid using decorative images when possible.

If the mark as decorative option is not available, you can simply put “” to denote the image as decorative.

NOTE: Use your best judgement on whether or not a visual element is adding value to the understanding of a document. A good rule of thumb would be to have at least two good reasons as to why the visual is critical to the understanding of a document.



[bookmark: Image_Layouts][bookmark: _bookmark14]Image Layouts
When combining images with text, it’s important to make sure that assistive technologies reads them in the order that is intended. This is why it is important to use the Layout Options that Microsoft Office provides instead of using extra spacing or returns.

Step 1: Images need to be In Line with Text in order to be accessible. On the Accessibility ribbon, choose Layout and In Line with Text (Windows users) or In Line with Text in the Accessibility ribbon (Mac users).



[bookmark: _bookmark15]Microsoft PowerPoint
Z- order is the order in which objects are placed on the slide. Assistive technologies will read these objects in z-order. We want to make sure that we put our objects in the order that we want assistive technologies to read them.

Step 1: Select a text box or shape on your slide.

Step 2: On the Accessibility ribbon, select the Selection Pane icon.
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Step 3: A Selection Pane window will open on the right-hand side of your window.

[image: ]

Step 4: Items in the selection pane are read bottom to top by assistive technologies. The first thing we want read on this slide is the Title, therefore it needs to be the last thing on the list, as shown above.  Make sure that the remainder of your slide content is in this order.


[bookmark: Tables][bookmark: _bookmark16]Tables
The purpose of tables is to present information in a grid, or matrix, and to demonstrate relationships between variables in an easy-to-understand fashion. Sighted users scan a table to make associations between data in the table and their appropriate row and/or column headers. Assistive technology users make these same associations with tables using column headers. Tables should not be used for formatting or any other purpose than to present tabular data. Cells should not be left empty for formatting purposes within tables. Try to keep your tables simple.

Step 1: Make sure the Header Row and First Column row checkboxes are checked in the left-hand corner of the Table Design ribbon.

[image: ]


Step 3: In the Table Layout ribbon, click repeat header rows in the right-hand corner if your table spans multiple pages.

[image: ]

Step 4: Next you need to add alternate text to your table. Make sure your cursor is in your table and select the Alt Text icon from the Accessibility ribbon.

Step 5: Click on the Alt Text tab in the Table Properties Box.

[image: ]

Step 6: Add a short descriptive Title (if you have a Title field). Rather than trying to describe the whole table in the Description field, the best thing for you to do is to add alternate text on what’s important about this table. For example, you might say, “Row one is a higher value than any other values.”

Step 7: Click OK.


[bookmark: Links][bookmark: _bookmark18]Links
Hyperlinks in documents allow users to visit web pages, navigate to headings and bookmarks within the document and open email links. Assistive technology users may skim a document by navigating from link to link. Avoid ambiguous link text that is difficult to understand out of context (e.g., “click here”).

Follow these principles to create accessible links:
· Use descriptive link text that does not rely on context from the surrounding text.
· Keep the amount of text in the link to a minimum.
· Avoid using the actual link within the text of the document. You should hyperlink text within the document. If you want to include the full URL for documents that may be printed, include them on a Resources page at the end of the document (as done in this curriculum), in a footnote or an unlinked URL in parenthesis directly after the linked text.

Examples of Incorrect Use of Links:
Click Here to order your new computer today!
*The example above does not use descriptive link text and relies on context from the surrounding content.

Visit https://www.extension.iastate.edu/it/ordering-new-computers/ to order your new computer today!
*The example above uses the actual link within the text of the document

Examples of Correct Use of Links:
Order your new computer today!
*The example above uses descriptive link text that does not rely on context from the surrounding content.

Order your new computer today! (https://www.extension.iastate.edu/it/ordering-new-computers)
*The example above provides hyperlinked text as well as the unlinked full URL in the document.

Step 1: Highlight the text that you want to link.
[image: ]

Step 2: Select Hyperlink or Link from the Accessibility ribbon.






Step 3: You can use this same pop-up window to hyperlink text to another file or document. Just click the “Select” button next to the address field and navigate to the file.

NOTE: If you link to a separate file or document, please remember that the document cannot be saved on your computer or shared drive if you want others to be able to access it (an exception would be if the document were internal and all of the potential users would be able to access items on the shared drive).

Step 5: To enter a link within the document, make sure you are on the “Place in This Document” section of the Insert Hyperlink pop-up. Use the bookmarks or headings in the text box to select the location within the document that you want to link to.



Step 6: To enter a link to an email address, make sure you are on the Email Address section of the Insert Hyperlink pop-up. Enter the email address preceded by mailto: and if you wish a subject line for the email.

Example: mailto:example@email.com

Step 7: Click OK when you are done inserting your hyperlink.

Step 8: If you are using the full URL of a link instead of hyperlinking text (for printing purposes) you will need to add a ScreenTip. Click ScreenTip in the Hyperlink dialog window and enter descriptive text in the pop-up box.

When you remove a link, the link styles will still be applied to the text. To remove styles on text, highlight the text and apply a different style or select the normal style.

[bookmark: _bookmark19]
[bookmark: Lists][bookmark: _bookmark20]Lists
Lists add important hierarchical structure to a document. Using the Tab button to indent content provides visual structure for sighted users, but it does not provide the document structure needed for assistive technology users.

When possible, use the list options provided by MS Office. This ensures that lists are read appropriately by assistive technologies. Don’t create lists manually by simply inserting numbers, characters, images or other symbols before list items. You can define new bullet or number formats for custom bullets or numbers.
[bookmark: List_Types][bookmark: _bookmark21]List Types
There are two types of lists used in Microsoft Office: ordered and unordered.
· Ordered (numbered) lists are used to present a group of items that follow a sequence.
· Unordered (bullet) lists are used for a group of items without a sequence.

Step 1: To create a bulleted list, click the button in the Accessibility ribbon either before typing your first list item or highlight the text you want as a list and click the bulleted list button.

Step 2: To create a numbered list, click the button on the Accessibility ribbon either before typing your first list item or highlight the text you want as a list and click the numbered list button.



[bookmark: Microsoft_PowerPoint][bookmark: _bookmark22]Microsoft PowerPoint
Additional instructions specific to Microsoft PowerPoint
[bookmark: Accessible_Charts][bookmark: _bookmark23]Accessible Charts
Two things to consider when making charts accessible.
1. Someone may be using assistive technology and will not be able to see the chart.
2. Someone may be colorblind and not able to tell the difference between red and green or blue and yellow on the chart.

Step 1: Select the border of your chart (the border must be selected in order to be able to add alt text).

Step 2: Select the Alt Text icon from the Accessibility ribbon or right click on the image and select Edit Alt Text…

Step 3: Add a title (if available) and description.  Try to articulate the primary point of showing the chart in the description field. For instance, you might say that series 3 has the highest value, that way anyone using assistive technology can understand the meaning of the chart.

Step 4: In the Accessibility ribbon, select Shape Fill and change the color of the line.

Step 5: To change the pattern, click on the Format ribbon and click the Format Pane icon.

Step 6: This will open a window in the left-hand side of your document.  Click on the paint button icon.


Step 7: Click Pattern fill in the fill section and choose a pattern from the options presented.

[image: ]



[bookmark: How_Color_Impacts_Accessibility][bookmark: _bookmark24]How Color Impacts Accessibility
Color can have a big impact on the understanding of a document and the information it portrays. This is not only true for low vision users, but also users with color blindness. The two primary types of color blindness, red-green and blue-yellow, cause individuals to have trouble differentiating between these two colors. It’s important not to use these colors together when trying to convey meaning.

Example:
It is important to consider color blindness when using color to convey meaning.

In the example above, the word “important” is green to differentiate it from the rest of the sentence. This differentiation will not be visible for users that are color blind, however. This differentiation will not be visible even for users who are not colorblind if the document is printed in grayscale. To make the word stand out, you could bold the word “important” instead.

Low vision users may need a higher contrast of colors in order to effectively understand your message. WCAG level AA criteria requires contrast ratios to be at least:
· 4.5:1 for normal text (14-16 pt)
· 3:1 for larger text (14 pt bold or 18 pt)

Color documents that are accessible adhere to two key rules:
· Provide ample contrast between foreground and background colors
· Do not rely on color alone to convey information

If designing your own paragraph styles, check color contrast for various foreground and background colors by using a color contrast checker (such as WebAIM: Color Contrast Checker or Contrast Checker).


[bookmark: Accessibility_Checker][bookmark: _bookmark25]Accessibility Checker
Microsoft Office provides an Accessibility Checker for identifying and repairing accessibility issues. The checker classifies accessibility issues into three categories:
· Errors: content that makes a document very difficult or impossible for people with disabilities to access.
· Warnings: content that in most – but not all – cases make the document difficult for people with disabilities to access.
· Tips: content that people with disabilities can access, but that might be better organized or presented.

Step 1: To run the Accessibility Checker, click on the Accessibility ribbon and select the Accessibility Checker icon.


Step 2: This will open a right-hand sidebar in your document that shows the results of the checker.

Step 3: The Inspection Results show the type of Error, Warning or Tip (Missing alternative text in the screenshot below). When clicking on the specific error, warning or tip (like Picture 175 in the example), you will be rerouted to that specific place within the document.

[image: ]


Step 4: When clicking on a specific error, warning or tip more information is provided below the Inspection Results window. The reason for the error, warning or tip is given as well as steps to correct it.

Step 5: Make sure that there is nothing listed in the Inspection Results. There are several things you will have to verify on your own, such as color contrast and reading order. Once you have completed these steps your document is ready to be shared.

NOTE: If you are running the Accessibility Checker on an older document, you may notice that it is unable to check the document due to compatibility mode. There are two possible solutions to this error:
1. Make sure the document is saved as a .docx file type



[bookmark: Saving_the_Document][bookmark: _bookmark26]Saving the Document
[bookmark: Add_a_Title_to_Your_Document][bookmark: _bookmark27]Add a Title to Your Document
Step 1: Click on the Accessibility ribbon and Properties or Go to File -> Info.

Step 2: In Properties (on the right-hand side), enter the title of your document. You can also enter the subject, author and company information. Adding categories and tags will help search engines more easily find your file online. You may need to click on “Advanced Properties” to see all available options.

NOTE: The Author is the name of the individual(s) who wrote the content, not the organization or business name.

Step 3: You can just click the back arrow when you are done.
[bookmark: Mac_Users]
If you are saving your document as the default document type in Microsoft Office products, you can save as you normally would after this step and all of your accessibility configurations will be preserved.

If you are saving your document to be exported as a PDF there are certain steps that you need to take to ensure that all of your accessibility configurations transfer to the PDF, view the Saving for PDF section below for next steps.


[bookmark: Microsoft_Excel][bookmark: _bookmark28]
[bookmark: Saving_for_PDF][bookmark: _bookmark29]Saving for PDF
To save your document as an accessible PDF, follow the instructions below.

Step 1: Click on the Save As icon in the Accessibility ribbon, or go to File -> Save As. Choose where you want the file to be saved and then type the file name in the Save As text box.


Step 2: In the Save As dialog box, click on the file format drop down box. Use the down arrow to browse through file types and select PDF. You may need to click the More options… link under the file type to get the Save As dialog box.

Step 3: Windows users will need to select the Options… button and verify that Document structure tags for accessibility is checked.  Click OK.

[image: ]

Step 4: Select Save.


[bookmark: Resources][bookmark: _bookmark30]Resources
Word Accessibility Ribbon (Windows) - https://iastate.box.com/s/tkgm5j1qkb0xcd0ynpbc9fi2zs5r0qj2

Excel Accessibility Ribbon (Windows) – https://iastate.box.com/s/iu9tsckq25fauibp1kvx6r1ju1rjoh2a

PowerPoint Accessibility Ribbon (Windows) – https://iastate.box.com/s/88vkzk09duylirx7nvc7ylsxwl8kqm5v

Word Accessibility Ribbon (Macs) – https://iastate.box.com/s/wowds3f1lzd7owjs41qpmc8cbglgflbq

Excel Accessibility Ribbon (Macs) – https://iastate.box.com/s/qdglyrnvsnleu3jtgjfbonhan456tmw5

PowerPoint Accessibility Ribbon (Macs) – https://iastate.box.com/s/ujqlpczabicgp8t939n0mtx9zzeqpgpy
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